
 
 

 

 

 

Anexo A 
Guías prácticas sistema de prototipado rápido 

basado en máquinas de control numérico CNC 
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Anexo B 
Guías de instalación software CAM (CamBam, 

RhinoCAM, MeshCam) 
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Instalación del software CamBam. 
 

En la siguiente guía se muestra como realizar la instalación del software CAM  “CamBam”. 

Antes de la instalación, verificar que los requisitos de instalación se cumplen. CamBam 

requiere un sistema operativo Windows © XP, Vista o 7 y el software .Net en la versión 3 o 

superior. 

Para descargar una versión de evaluación del programa, abrir un navegador web y dirigirse al 

vínculo: http://www.cambam.info/downloads/  Descargar el archivo y ejecutarlo con permisos de 

administrador para iniciar la instalación.  

 

Figura B.1. Ventana de bienvenida 

En la ventana se muestra la licencia del software. Luego de leer marcar el botón “I Agree” 

(Estoy de acuerdo). Pulsar el botón “Next >” para continuar. 

 

Figura B.2. Términos de contrato 

En la ventana a continuación, seleccionar en el cajón la ruta de instalación del programa (como 

recomendación, dejar por defecto). Para continuar presionar el botón “Next >”. 

http://www.cambam.info/downloads/
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Figura B.3. Ubicación de la instalación 

En la siguiente ventana, se solicita confirmar los datos anteriores. Si se desea cambiar algún 

tipo de información, pulsar el botón “< Back”, para regresar a las ventanas anteriores. Para 

confirmar, pulsar el botón “Next >” y con eso dará comienzo la instalación. 

 

Figura B.4. Confirmación de instalación. 

 

Figura B.5. Proceso de instalación. 
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Confirmar los permisos de usuarios en el mensaje emergente como se muestra a continuación, 

presionando el botón “Yes”. 

 

Figura B.6. Autorizar permisos de administrador. 

Luego de la copia de archivos, el asistente muestra algunas notas acerca del programa y sus 

funcionalidades. Luego de leer presionar el botón “Next >” para culminar la instalación. 

 

 

 

 

 

 

 

Figura B.7. Notas acerca de CamBam 

La última ventana muestra que el proceso de instalación se ha completado. El software 

CamBam ahora está listo para usarse. Para cerrar, presionar el botón “Close” y finalizara la 

instalación. El manejo de este software se especifica dentro de la práctica correspondiente. 

 

 

 

 

 

 

 

Figura B.8. Finalización de la instalación. 
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Instalación de Rhino3D y RhinoCAM 
 

En el siguiente documento, se explica la forma y el orden en que se debe instalar el software 

“Rhinoceros”, para posteriormente ser utilizado en las prácticas. 

En la página web de Rhino3d se pude adquirir una versión de evaluación totalmente funcional. 

La última versión lanzada al momento de realizar este documento es la v5.0. Para descargar el 

software, abrir un navegador web e ir a la dirección: 

 http://www.rhino3d.com/es/download/rhino/5.0/evaluation 

Al terminar la descarga, ejecutar el archivo como administrador para evocar los permisos 

necesarios en su instalación. Al momento de la ejecución, el asistente reunirá los datos 

necesarios para realizar la correcta instalación. Cuando haya terminado, emitirá un mensaje 

como el que se ve a continuación, indicando que ya es posible continuar. 

 

Figura B.9. Ventana de bienvenida 

Pulsar el botón “Siguiente” para continuar. En la siguiente ventana se muestra el contrato de 

licencia con el cual, luego de leer, se solicita aceptar los términos del contrato. Marcar la casilla 

donde se acepta el contrato de licencia y posteriormente pulsar el botón “Siguiente” para 

continuar. 

http://www.rhino3d.com/es/download/rhino/5.0/evaluation
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Figura B.10. Términos de licencia del software 

En la siguiente ventana, llenar los campos con los datos de usuario. Se sugiere llenar el campo 

de “User Name” con el nombre de “Unicauca”. Pulsar el botón “Siguiente” para continuar 

 

Figura B.11 Información de datos de usuario. 

En la siguiente ventana, se solicita confirmar los datos anteriores. Si se desea cambiar algún 

tipo de información, pulsar el botón “Atrás”, para regresar a las ventanas anteriores. Para 

confirmar, pulsar el botón “Instalar” y con eso dará comienzo la instalación. 
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Figura B.12. Confirmación de instalación.  

 

Figura B.13. Proceso de instalación. 

En el momento que haya terminado la instalación, se emitirá una nueva ventana como la que 

se muestra a continuación. Para cerrar el asistente, pulsar el botón “Finalizar” y ya está listo el 

programa Rhinoceros 5 para ser utilizado. 
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Figura B.14. Instalación finalizada. 

Ejecutar el programa desde el ícono en el escritorio (Rhinoceros 5.0) o desde el menú inicio 

(Todos los programas -> Rhinoceros 5.0 -> Rhinoceros 5.0). El programa se abrirá y estará 

listo para ser utilizado.  

 

Figura B.15. Software CAD Rhinoceros 

Posterior a la instalación del software Rhino3d, se procede con la descarga del plugin 

RhinoCAM. Este plugin es el que permite realizar las tareas CAM sobre las piezas en cuestión 

y la generación de código. Para descargar una versión de evaluación de RhinoCAM, abrir el 

navegador y dirigirse al siguiente link: http://mecsoft.com/downloaddemos/ 

Llenar los datos solicitados y seleccionar el producto RhinoCAM. Con esto empieza la 

descarga. Para instalar el plugin, ejecutar el archivo con permisos de administrador. El 

asistente dará comienzo recogiendo los requisitos para una correcta instalación. 

Una vez listo, el asistente muestra una ventana indicando que ya es posible continuar. Pulsar el 

botón “Next >” para continuar. 

http://mecsoft.com/downloaddemos/
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Figura B.16. Ventana de bienvenida 

 

Figura B.17. Inicialización de la instalación de RhinoCAM 

Una ventana muestra el contrato de licencia por el software. Luego de leer el contrato, aceptar 

los términos marcando el botón correspondiente y pulsar el botón “Next >” para continuar. 

 

Figura B.18.  Términos de licencia 
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En la siguiente ventana, se muestra la información del programa, los requisitos de hardware y 

de software y algunas recomendaciones de uso. Luego de leer, pulsar el botón “Next >” para 

continuar. 

 

Figura B.19. Requisitos y notas acerca de RhinoCAM 

Posteriormente, en el siguiente paso se define la ruta donde se instalara el plugin. Es 

recomendable dejar el valor por defecto para no alterar los vínculos entre el plugin y el software 

Rhino3d. Pulsar el botón “Next >” para continuar, lo cual dará comienzo a la instalación. 

 

Figura B.20. Ubicación de la instalación. 

Al terminar la instalación, una última ventana indicara que el proceso ha terminado y ya es 

posible utilizar el plugin con rhino3d. Pulsar el botón “Finish” para dar por culminada la 

instalación. 
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Figura B.21. Instalación completada. 

Con esto culmina la instalación del software necesario para realizar las prácticas 

correspondientes a Rhino3D. La utilización, carga de archivos, generación de código, entre 

otros; se especifican dentro de la práctica misma. 
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Instalación del software MeshCam 
 

En la siguiente guía se muestra como realizar la instalación del software CAM  “MeshCAM”. 

Antes de la instalación, verificar que los requisitos de instalación se cumplen. MeshCAM 

requiere un sistema operativo Windows © XP, Vista o 7. En Linux es posible instalarlo mediante 

el emulador de aplicaciones de Windows “Wine”. 

MeshCAM es una versión registrada completamente funcional y con soporte técnico, a 

diferencia de los 2 software CAM utilizados en las otras prácticas de laboratorio, que utilizan 

licencias de evaluación, A continuación se muestra como hacer la instalación desde Linux 

Ubuntu. Si se desea instalar en Windows, saltar los pasos hasta la página donde se indica la 

descarga del archivo. 

Para la instalación en Ubuntu, es necesario primero instalar el programa “wine” que permite 

emular aplicaciones de Windows bajo Linux. Para ello, abrir una terminal y ejecutar el siguiente 

comando: 

~$ sudo apt-get install wine 

El sistema solicitara la contraseña del equipo y generará una lista de los paquetes necesarios y 

el tamaño de la instalación. Para continuar presionar “S” y luego Enter. 

 

Figura B.22. Lista de paquetes, espacio necesario y confirmación de instalación. 

A partir de aquí, comenzará la descarga de las fuentes necesarias y la posterior instalación del 

programa. 
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Figura B.23. Descarga de la aplicación WINE. 

Igualmente, es posible realizar el anterior proceso a través del gestor de paquetes Synaptic. 

Para ejecutarlo ir a Sistema->Administrar->Synaptic y se abrirá una ventana como se 

muestra a continuación. Buscar la aplicación “wine” y marcar para instalar. Automáticamente se 

seleccionan las dependencias necesarias para su instalación. 

 

Figura B.24. Gestor de paquetes Synaptic 

Completada la anterior etapa, ya es posible ejecutar aplicaciones de Windows bajo Ubuntu. 

Para descargar el archivo de MeshCAM shareware, abrir un navegador web y dirigirse al 

siguiente vínculo: http://www.grzsoftware.com/dl/  

Ejecutar el archivo descargado para dar comienzo a la instalación.    

http://www.grzsoftware.com/dl/
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Figura B.25. Ventana de bienvenida. 

Presionar el botón “Next >” para continuar con la instalación. En la siguiente ventana, el 

programa solicita tener acceso a datos anónimos acerca del uso de la aplicación para 

retroalimentación y mejora de la misma. Seleccionar cualquiera de los dos y pulsar el botón 

“Next >” para continuar. 

 

Figura B.26. Participación en el programa de experiencia de usuario. 

A continuación se muestra los términos de la licencia de la aplicación. Luego de leerlos, marcar 

la opción que acepta los términos y pulsar el botón “Next >” para continuar. 
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Figura B.27. Términos de contrato del software 

En el cuadro de la siguiente ventana, se solicita la ruta donde se instalará el programa. Se 

recomienda dejar por defecto. 

 

Figura B.28. Ubicación de la instalación. 

Posteriormente, se solicita confirmar los datos ingresados anteriormente para continuar con la 

instalación. Si se desea cambiar algún parámetro, presionar el botón “< Back” para ir a la 

ventana correspondiente. Para dar inicio a la instalación, presionar el botón “Install”. 
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Figura B.29. Confirmación de instalación. 

Cuando haya finalizado la instalación, se emitirá un mensaje indicando que ya es posible hacer 

uso de la aplicación. Para cerrar el asistente, presionar el botón “Finish”. 

 

Figura B.30. Finalización de la instalación. 

Para ejecutar la aplicación, presionar el ícono de MeshCAM ubicado en el escritorio. Al utilizar 

por primera vez la aplicación, se emite un mensaje solicitando el lenguaje en el cual se hará 

uso. 
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                                                      (a)                                                 (b) 

Figura B.31. (a) Icono del programa (b) Ventana de selección de lenguaje 

Para registrar la versión, ir al menú Help->Register. Esto desplegará una ventana con campos 

para introducir los datos de registro. Solicitarle el ingreso de los datos al encargado del 

laboratorio y confirmar presionando “OK”. Con esto, la versión queda registrada y 

completamente funcional. 

 

 

Figura B.32. Cuadro de datos para registro. 
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Figura B.33. Software CAM MeshCAM 

Con esto culmina la instalación del software necesario para realizar las prácticas 

correspondientes a MeshCAM. La utilización, carga de archivos, generación de código, entre 

otros; se especifican dentro de la práctica misma. 
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Anexo C 
Instalación, configuración y uso del script PCB-

GCode 
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Instalación, configuración y uso del script PCB-GCode 
 

En el siguiente documento, se explica el funcionamiento del script “PCB-GCode” que 

básicamente permite generar el gcode de circuitos impresos diseñados mediante el software 

“Eagle”. Los requisitos se limitan únicamente a tener la aplicación Eagle versión 5 o 6 de 

CadSoft instalada en el sistema operativo. 

Para descargar el script, abrir un navegador web y dirigirse al siguiente vinculo: 

http://pcbgcode.org/list.php?12 

Aparecerá entonces una lista con las actualizaciones del programa y la versión de Eagle en 

que funcionan. Al momento de realizar esta guía, la última versión lanzada y de la que se hará 

uso es la 3.6.0.4. Abrir el link correspondiente a esta versión y descargar el archivo. 

El archivo descargado, de tipo comprimido “.rar”, contiene los archivos necesarios para correr 

el script. Para continuar, descomprimir la carpeta en algún lugar de fácil acceso. 

Ejecutar el programa Eagle y en el menú abrir Options->Directories. En la ventana emergente, 

actualizar la casilla frente a “User Language Programs”, con la ruta de la carpeta que contiene 

el script anteriormente descargado.  

 

Figura C.1. Ventana de directorios de la aplicación. 

Para hacerlo, seguido de “$EAGLEDIR\ulp” agregar un “;” y luego sin espacios, la ruta de la 

carpeta. Ejemplo: 

$EAGLEDIR\ulp;C: \pcb-gcode3.4 

Presionar “OK” para guardar los cambios y posteriormente cargar el archivo que contiene el 

diseño del circuito. El objetivo de esta guía es mostrar como funciona el script, así que no se 

hará énfasis en el manejo de la aplicación o en el diseño de los circuitos. Para mostrar el 

funcionamiento, se ha cargado el diseño de un Arduino MEGA. 

http://pcbgcode.org/list.php?12
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Figura C.2. Software de diseño EAGLE de CadSoft 

Para generar el gcode, dirigirse a menú File->Run ULP. En la ventana emergente buscar la 

ubicación de la carpeta que contiene el script de “pcb-gcode” y cargar el archivo “PCB-GCode -

setup.ulp” 

 

Figura C.3. Ventana de selección de archivos 
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Esto lanzará la aplicación de PCB-GCode como se muestra en la imagen. 

 

Figura C.4. Interfaz de usuario de PCB-GCODE 

La aplicación contiene 6 pestañas, en la cuales se configura los parámetros del trabajo. En la 

primera, “General Options”, están aquellas opciones donde se configura la forma del 

maquinado y los valores generales de profundidad, distancia y tamaño de paso sobre la placa. 

 

Figura C.5. Contenido de la pestaña “General Options” 

En la segunda pestaña “Machine”, se configuran las unidades de medida, las velocidades y los 

rangos de trabajo sobre la placa. 
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Figura C.6. Contenido de la pestaña “Machine”. 

En la tercera pestaña “GCode Style”, se selecciona el estilo del GCode. Esta es una forma 

sencilla de describir el tipo de Post procesador a usar, enseñando el tipo de maquina sobre el 

cual se planea realizar el circuito impreso. Para la máquina en uso, se utiliza el primero en la 

lista “EMC”. 

 

Figura C.7. Contenido de la pestaña “GCode Style”. 

La cuarta pestaña “GCode Options”, modifica las características del archivo GCode. En estas 

opciones, se modifica el formato del código, los nombres de operación, nombres de archivo, 

entre otros. 
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Figura C.8. Contenido de la pestaña “GCode Options”. 

En la quinta pestaña “Plugins”, se dispone de una calculadora para los respectivos cómputos 

de unidades y demás. La sexta y última pestaña “Other” permite reiniciar todos los parámetros 

definidos en las anteriores pestañas a los valores por defecto. 

Luego de configurar como se desea los parámetros anteriores (por lo general los valores por 

defecto funcionan adecuadamente), presionar el botón “Accept” si se desea continuar 

trabajando sobre el circuito, o “Accept and make my board” para generar el gcode con los 

recorridos del circuito. 

Si se seleccionó la segunda opción, el sistema comenzara con la generación de los códigos y 

al culminar muestra una imagen con el resultado final, como se muestra a continuación. 

 

Figura C.9. Diseño de los recorridos de la herramienta. 
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Los códigos se generan en la carpeta de trabajo de Eagle. En caso de no tener la extensión 

“.ngc” para ser leida por EMC, simplemente renombrar el archivo y agregar o cambiar la 

extensión, sea el caso, por “.ngc”. 

Si la opción seleccionada fue la primera, basta con ir a menú File->Run ULP y seleccionar el 

archivo “pcb-gcode.ulp” para generar los códigos automáticamente. En tal caso, se repite el 

paso anterior. 

Si se desea por algún motivo modificar nuevamente los parámetros del gcode a generar, cargar 

el archivo “pcb-gcode-setup.ulp” y editar los datos. De cualquier otra manera, si los parámetros 

introducidos en un comienzo son suficientes, simplemente basta con cargar el archivo “pcb-

gcode.ulp” para generar automáticamente los archivos gcode. 

Con esto termina la guía de uso del script “PCB-GCode” sobre Eagle, para la generación del 

GCode que contiene los datos referentes a la maquinación de circuitos impresos PCB. 
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Anexo D 
Guía armado de maquina fireball V90 
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Guía armado de maquina fireball V90 

La mejor manera de empezar con el ensamble es conseguir una pieza de alfombra suave para 
ubicar sobre esta la V90. Si esto no es posible se debe tener cuidado de no rayar ninguna de 
las piezas durante el ensamblado.  

 

Para ensamblar la V90 es necesario: 

 Tuerca y llave de 7/16 "  

 Llaves Allen de 3/32 "y 7/64"  

 Destornillador Phillips # 2 y # 3  

 Destornillador plano 

 Acetona y trapo 

 

Se debe iniciar limpiando los rieles con acetona. Estos son empacados con cera antes del 

envío, y esta podría obstruir los orificios de engrasado en los rodamientos. Posteriormente, se 

insertan los rieles y el montaje del eje z en los soportes que se aprecian a continuación. El 

conjunto de eje z utiliza los dos rieles más cortos. 

 

Figura D.1. Rieles 

 

Ubique los rieles a un costado y reúna el resto de piezas del soporte. 
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Figura D.2. Piezas del soporte 

 

Coloque los bujes  de 5/8 " (blancos) a los extremos del soporte negro que se aprecia en la 

siguiente imagen. No apretar completamente las tuercas, ya que estas necesitarán un ajuste 

posterior. 

 

 

Figura D.3. Ubicación de bujes 
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Deslice los soportes sobre los rieles, como se aprecia a continuación. 

 

Figura D.4. Ubicación rieles al soporte 

Coloque las piezas superior e inferior del marco e inserte los chasos cortos como se indica en 

la siguiente figura. Las ranuras de la pieza inferior deben quedar mirando hacia abajo como se 

puede apreciar a continuación. 

 

Figura D.5. Introducción de chasos al soporte 
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Apriete con fuerza las tuercas a los chasos cortos. 

 

Figura D.6. Chasos apretados al soporte 

 

En este punto se comienza a apretar todas las tuercas del soporte incluyendo los bujes y 

finalmente se alinean los rieles. No apretar las tuercas de los bujes demasiado fuerte.  

 

 

Figura D.7. Bujes apretados al soporte 
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Después de que el montaje del eje z se deslice suavemente, se puede instalar las piezas del 

tornillo de avance superior. 

 

 

Figura D.8. Piezas tornillo de avance 

Insertar en un extremo el tornillo de avance, deslice el conjunto de rodamiento, arandela de 

nylon, y abrazadera de tensión como se aprecia en la siguiente imagen. El servomotor que 

controlará este eje se puede ubicar en ambos extremos debido al diseño del soporte. 

 

 

Figura D.9. Instalación extremo A del tornillo de avance 
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Se atraviesa el montaje del eje z, y sobre el tornillo de avance se deslizan, la otra abrazadera 

de tension, arandela de nylon, y el conjunto de rodamiento. Se apretan las abrazaderas en 

cada extremo del eje de tal manera que aproximadamente 3/4" del acoplamiento de latón 

quede expuesta fuera del extremo del soporte, para conectar ahí el servomotor. 

 

 

Figura D.10. Instalación extremo B del tornillo de avance 

Ahora, se instalan las partes de la tuerca conductora inferior 

 

 

Figura D.11. Partes tuerca conductora inferior 
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A continuación se muestra cómo debe quedar instalada la tuerca conductora inferior. Nota: Los 

dos arandelas van entre el soporte de la tuerca conductora y el soporte negro. Actúan como 

separadores si se requieren ajustes futuros. 

 

 

Figura D.12. Tuerca conductora inferior instalada 

De esta forma se finaliza el montaje de este soporte. 

 

Figura D.13. Soporte armado 
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A continuación, se ensambla la estructura base. En la Figura D.14 se observan las piezas de 

los extremos de la base. 

 

 

Figura D.14. Piezas de los extremos de la base 

Apretar fuertemente los finales de riel en los extremos de la base. 

 

 

Figura D.15. Apretado de finales de riel  
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A continuación, se instalan las piezas de las barras de soporte para la mesa. 

 

 

Figura D.16. Piezas de las barras de soporte para la mesa 

Se colocan las barras de soporte para la mesa. Se aprietan las tuercas fuertemente. 

 

 

Figura D.17. Barra de soporte de mesa sujeta a bases 
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Ahora se deben reunir las piezas de la estructura base. 

 

 

Figura D.18. Piezas de la estructura base 

Se toma el extremo de la estructura que no tiene los agujeros de montaje del motor. Se coloca 

esta pieza hacia abajo y luego apoyarla a los extremos sobre bases (en la figura las bases son 

revistas) de tal forma que quede nivelado y no tambalee sobre las cabezas de los tornillos.  

 

 

Figura D.19. Extremo de estructura dispuesta para recibir rieles. 
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Ubique los rieles en los finales de riel. Se debe considerar la orientación de los rieles como se 

aprecia en la siguiente Figura. Los orificios de los tornillos deben quedar por dentro, mientras 

que los rodamientos deberán estar expuestos en el lado inferior. 

 

 

Figura D.20. Rieles ubicados sobre los finales de riel. 

Se colocan los tubos de PVC en sus ranuras. Los logos deben ir hacia abajo y afuera.  

 

Figura D.21. Tubos PVC ubicados sobre bases laterales 
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Se ubica con cuidado la otra pieza final en la parte superior de los rieles y tuberías. Se alinean 

los tubos mientras se presionan los rieles a su lugar. Se Presiona hacia abajo hasta que quede 

firme. 

 

 

Figura D.22. Adecuación de la siguiente base lateral con tubo y rieles 

Se inserta una arandela y la tuerca de caperuza en los extremos de las cuatro barras de 

tensión. 

 

 

Figura D.23, Barras de tensión  
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A continuación, colocar cada barra de tensión en los respectivos orificios y se aprietan a mano. 

 

 

Figura D.24. Apretado manual de barras de tensión  

Se toman ambos extremos para aplicar presión y se coloca cuidadosamente el marco sobre el 

tapete. 

 

 

Figura D.25. Ubicación de la estructura sobre tapete 
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Ahora se instalan las arandelas y tuercas en el otro extremo de las barras de tensión y se 

aprietan nuevamente a mano.  

 

 

Figura D.26. Apretado del siguiente extremo de las barras de tensión 

Se ajusta el soporte del eje z (armado al inicio de la guía, ver Figura D.13) a los rieles mediante 

seis tornillos en el tren de deslizamiento. Una arandela y una tuerca van al lado inferior de cada 

tornillo. Nota: Al apretar los tornillos se debe verificar que el tren se desplaza fácilmente  de un 

extremo al otro empujándolo con el dedo. 

 

 

Figura D.26. Ajuste de soporte a tren de desplazamiento 
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Piezas del tornillo de avance largo. 

 

 

Figura D.27. Piezas del tornillo de avance largo. 

El tornillo de avance largo (Eje x) se debe instalar de la misma forma que se instaló el tornillo 

de avance en el soporte del eje z (Ver Figura D.9, D.10). 

 

 

Figura D.28. Instalación del tornillo de avance largo   
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En la instalación de los motores se utilizan los tornillos de 10-24 x 2 " para metales y 

separadores. Nota: Una arandela numero 10 debe colocarse entre cada pilar y el motor. 

 

 

Figura D.29. Instalación de motores 

Se instala la tapa de la mesa con los tornillos  de 1/4-20 x 5 "  

 

 

Figura D.30. Instalación tapa de la mesa 
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A continuación, se conecta el soporte del motor al eje z e instalar la herramienta Dremel. 

 

Figura X.31. Conexión del soporte de la herramienta Dremel 

 

El último paso es realizar las conexiones eléctricas. 
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Anexo E 
GCode 
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GCode 
 

NC Programming Codes 

NC Programming as per ISO (DIN 66025) and RS274 

G-Codes simple definition  
 
G00     Rapid traverse  
G01     Linear interpolation with feedrate  
G02     Circular interpolation (clockwise)  
G03     Circular interpolation (counter clockwise)  
G2/G3   Helical interpolation  
G04     Dwell time in milliseconds  
G05     Spline definition  
G06     Spline interpolation  
G07     Tangential circular interpolation / Helix interpolation / Polygon interpolation /                                                
 Feedrate interpolation 
G08     Ramping function at block transition / Look ahead "off"  
G09     No ramping function at block transition / Look ahead "on"  
G10     Stop dynamic block preprocessing  
G11     Stop interpolation during block preprocessing  
G12     Circular interpolation (cw) with radius  
G13     Circular interpolation (ccw) with radius  
G14     Polar coordinate programming, absolute  
G15     Polar coordinate programming, relative  
G16     Definition of the pole point of the polar coordinate system 
G17     Selection of the X, Y plane  
G18     Selection of the Z, X plane  
G19     Selection of the Y, Z plane  
G20     Selection of a freely definable plane  
G21     Parallel axes "on"  
G22     Parallel axes "off"  
G24     Safe zone programming; lower limit values  
G25     Safe zone programming; upper limit values  
G26     Safe zone programming "off"  
G27     Safe zone programming "on"  
G33     Thread cutting with constant pitch  
G34     Thread cutting with dynamic pitch  
G35     Oscillation configuration  
G38     Mirror imaging "on"  
G39     Mirror imaging "off"  
G40     Path compensations "off"  
G41     Path compensation left of the work piece contour  
G42     Path compensation right of the work piece contour  
G43     Path compensation left of the work piece contour with altered approach  
G44     Path compensation right of the work piece contour with altered approach  
G50     Scaling  
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G51     Part rotation; programming in degrees  
G52     Part rotation; programming in radians  
G53     Zero offset off  
G54     Zero offset #1  
G55     Zero offset #2  
G56     Zero offset #3  
G57     Zero offset #4  
G58     Zero offset #5  
G59     Zero offset #6  
G63     Feed / spindle override not active  
G66     Feed / spindle override active  
G70     Inch format active  
G71     Metric format active  
G72     Interpolation with precision stop "off"  
G73     Interpolation with precision stop "on"  
G74     Move to home position  
G75     Curvature function activation 
G76     Curvature acceleration limit 
G78     Normalcy function "on" (rotational axis orientation)  
G79     Normalcy function "off" 
G80 - G89 for milling applications: 
G80     Canned cycle "off"  
G81     Drilling to final depth canned cycle 
G82     Spot facing with dwell time canned cycle 
G83     Deep hole drilling canned cycle 
G84     Tapping or Thread cutting with balanced chuck canned cycle 
G85     Reaming canned cycle 
G86     Boring canned cycle 
G87     Reaming with measuring stop canned cycle 
G88     Boring with spindle stop canned cycle 
G89     Boring with intermediate stop canned cycle 
G81 - G88 for cylindrical grinding applications: 
G81     Reciprocation without plunge 
G82     Incremental face grinding 
G83     Incremental plunge grinding 
G84     Multi-pass face grinding 
G85     Multi-pass diameter grinding 
G86     Shoulder grinding 
G87     Shoulder grinding with face plunge 
G88     Shoulder grinding with diameter plunge 
G90     Absolute programming  
G91     Incremental programming  
G92     Position preset  
G93     Constant tool circumference velocity "on" (grinding wheel)  
G94     Feed in mm / min (or inch / min)  
G95     Feed per revolution (mm / rev or inch / rev) 
G96     Constant cutting speed "on"  
G97     Constant cutting speed "off"  
G98     Positioning axis signal to PLC  
G99     Axis offset  
G100   Polar transformation "off"  
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G101   Polar transformation "on"  
G102   Cylinder barrel transformation "on"; cartesian coordinate system  
G103   Cylinder barrel transformation "on," with real-time-radius compensation (RRC)  
G104   Cylinder barrel transformation with center line migration (CLM) and RRC  
G105   Polar transformation "on" with polar axis selections  
G106   Cylinder barrel transformation "on" polar-/cylinder-coordinates  
G107   Cylinder barrel transformation "on" polar-/cylinder-coordinates with RRC  
G108   Cylinder barrel transformation polar-/cylinder-coordinates with CLM and RRC  
G109   Axis transformation programming of the tool depth  
G110   Power control axis selection/channel 1 
G111   Power control pre-selection V1, F1, T1/channel 1 (Voltage, Frequency, Time)  
G112   Power control pre-selection V2, F2, T2/channel 1  
G113   Power control pre-selection V3, F3, T3/channel 1  
G114   Power control pre-selection T4/channel 1  
G115   Power control pre-selection T5/channel 1  
G116   Power control pre-selection T6/pulsing output  
G117   Power control pre-selection T7/pulsing output  
G120   Axis transformation; orientation changing of the linear interpolation rotary axis  
G121   Axis transformation; orientation change in a plane  
G125   Electronic gear box; plain teeth  
G126   Electronic gear box; helical gearing, axial  
G127   Electronic gear box; helical gearing, tangential  
G128   Electronic gear box; helical gearing, diagonal  
G130   Axis transformation; programming of the type of the orientation change  
G131   Axis transformation; programming of the type of the orientation change  
G132   Axis transformation; programming of the type of the orientation change  
G133   Zero lag thread cutting "on"  
G134   Zero lag thread cutting "off"  
G140   Axis transformation; orientation designation work piece fixed coordinates  
G141   Axis transformation; orientation designation active coordinates  
G160   ART activation  
G161   ART learning function for velocity factors "on"  
G162   ART learning function deactivation  
G163   ART learning function for acceleration factors  
G164   ART learning function for acceleration changing  
G165   Command filter "on"  
G166   Command filter "off"  
G170   Digital measuring signals; block transfer with hard stop  
G171   Digital measuring signals; block transfer without hard stop  
G172   Digital measuring signals; block transfer with smooth stop  
G175   SERCOS-identification number "write"  
G176   SERCOS-identification number "read"  
G180   Axis transformation "off"  
G181   Axis transformation "on" with not rotated coordinate system  
G182   Axis transformation "on" with rotated / displaced coordinate system  
G183   Axis transformation; definition of the coordinate system  
G184   Axis transformation; programming tool dimensions  
G186   Look ahead; corner acceleration; circle tolerance  
G188   Activation of the positioning axes  
G190   Diameter programming deactivation  
G191   Diameter programming "on" and display of the contact point  
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G192   Diameter programming; only display contact point diameter  
G193   Diameter programming; only display contact point actual axes center point 
G200   Corner smoothing "off"  
G201   Corner smoothing "on" with defined radius  
G202   Corner smoothing "on" with defined corner tolerance  
G203   Corner smoothing with defined radius up to maximum tolerance  
G210   Power control axis selection/Channel 2  
G211   Power control pre-selection V1, F1, T1/Channel 2  
G212   Power control pre-selection V2, F2, T2/Channel 2  
G213   Power control pre-selection V3, F3, T3/Channel 2  
G214   Power control pre-selection T4/Channel 2  
G215   Power control pre-selection T5/Channel 2  
G216   Power control pre-selection T6/pulsing output/Channel 2 
G217   Power control pre-selection T7/pulsing output/Channel 2 
G220   Angled wheel transformation "off"  
G221   Angled wheel transformation "on"  
G222   Angled wheel transformation "on" but angled wheel moves before others 
G223   Angled wheel transformation "on" but angled wheel moves after others 
G265   Distance regulation – axis selection  
G270   Turning finishing cycle  
G271   Stock removal in turning  
G272   Stock removal in facing  
G274   Peck finishing cycle 
G275   Outer diameter / internal diameter turning cycle 
G276   Multiple pass threading cycle 
G310   Power control axes selection /channel 3  
G311   Power control pre-selection V1, F1, T1/channel 3  
G312   Power control pre-selection V2, F2, T2/channel 3  
G313   Power control pre-selection V3, F3, T3/channel 3  
G314   Power control pre-selection T4/channel 3  
G315   Power control pre-selection T5/channel 3 
G316   Power control pre-selection T6/pulsing output/Channel 3 
G317   Power control pre-selection T7/pulsing output/Channel 3 

Note that some of the above G-codes are not standard. Specific control features, such as laser 
power control, enable those optional codes. 

  
M codes simple definition  
 
M00     Unconditional stop 
M01     Conditional stop  
M02     End of program  
M03     Spindle clockwise  
M04     Spindle counterclockwise  
M05     Spindle stop  
M06     Tool change (see Note below)  
M19     Spindle orientation  
M20     Start oscillation (configured by G35) 
M21     End oscillation 
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M30     End of program  
M40     Automatic spindle gear range selection  
M41     Spindle gear transmission step 1  
M42     Spindle gear transmission step 2  
M43     Spindle gear transmission step 3  
M44     Spindle gear transmission step 4  
M45     Spindle gear transmission step 5  
M46     Spindle gear transmission step 6  
M70     Spline definition, beginning and end curve 0 
M71     Spline definition, beginning tangential, end curve 0 
M72     Spline definition, beginning curve 0, end tangential 
M73     Spline definition, beginning and end tangential 
M80     Delete rest of distance using probe function, from axis measuring input 
M81     Drive On application block (resynchronize axis position via PLC signal during  the 
block) 
M101-M108   Turn off fast output byte bit 1 (to 8)  
M109   Turn off all (8) bits in the fast output byte 
M111-M118   Turn on fast output byte bit 1 (to 8)  
M121-M128   Pulsate (on/off) fast output byte bit 1 (to 8)  
M140    Distance regulation “on” (configured by G265) 
M141    Distance regulation “off” 
M150    Delete rest of distance using probe function, for a probe input (one of 16, M151-M168) 
M151-M158   Digital input byte 1 bit 1 (to bit 8) is the active probe input 
M159    PLC cannot define the bit mask for the probe inputs 
M160    PLC can define the bit mask for the probe inputs (up to 16) 
M161-M168   Digital input byte 2 bit 1 (to bit 8) is the active probe input 
M170    Continue the block processing look ahead of the part program (cancel the M171) 
M171    Stop the block processing look ahead of the probe input part program segment  

(like a G10) 
M200    Activate the handwheel operation in the automatic mode (to introduce an offset  
 in the program) 
M201-M208   Select the axis (by number from 1 to 8) for the handwheel operation 
M209    Activate the handwheel operation in the automatic mode, with PLC control of  

the axis selection 
M210    Deactivate the handwheel input while in the automatic mode 
M211    Deactivate this handwheel feature and also remove the handwheel offset (if  
 any) 
M213    Spindle 2 clockwise 
M214    Spindle 2 counterclockwise  
M215    Spindle 2 stop  
M280    Switchable spindle/rotary axis, rotary axis on, first combination 
M281    Switchable spindle/rotary axis, rotary axis on, second combination 
M290    Switchable spindle/rotary axis, spindle enabled, first combination 
M291    Switchable spindle/rotary axis, spindle enabled, second combination 
  
Note: Other machine functions, like tool change (usually M06) or coolant control, have their M-
code value specified by the PLC application not by the CNC software. Most of the M-code 
values in above list are configurable. 

Other M-codes (up to M699) can be handled by the PLC application based on the particular 
machine requirements. 


